### European regulations for construction products

This section includes both regulatory information and a summary on the declared performance according to the Construction Products Regulation 305/2011. For detailed information refer to the product Declaration of Performance (DoP).

<table>
<thead>
<tr>
<th>Certification</th>
<th><img src="https://via.placeholder.com/15" alt="CE" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification body</td>
<td>0370</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>UTC CCS Manufacturing Polska Sp. Z o.o. Ul. Kolejowa 24. 39-100 Ropczyce, Poland</td>
</tr>
<tr>
<td>Authorized EU manufacturing representative:</td>
<td>UTC Fire &amp; Security B.V. Kelvinstraat 7, 6003 DH Weert, Netherlands</td>
</tr>
<tr>
<td>Year of first CE marking</td>
<td>15</td>
</tr>
<tr>
<td>Declaration of Performance number</td>
<td>360-3519-0299</td>
</tr>
<tr>
<td>EN 54</td>
<td>EN 54-20: 2006</td>
</tr>
<tr>
<td>Product identification</td>
<td>See model number on product identification label</td>
</tr>
<tr>
<td>Intended use</td>
<td>See DoP point 3</td>
</tr>
<tr>
<td>Essential characteristics</td>
<td>See DoP point 9</td>
</tr>
</tbody>
</table>
Content

Important information iii
Advisory messages iv
EN 54-20 and UL installation v

Chapter 1 Product and component descriptions 1
Introduction 2
Available software for the detector 2
Specifications 3
Indicators 4
Inside the detector 5
Removable terminal block connections 6

Chapter 2 Installation and configuration 7
Introduction 8
Antistatic precautions 8
General installation guidelines 10
Docking station 10
Application 12
System design 12
Installation 17
Interfacing with fire alarm panels 21
Setting the detector address 23
Final installation 25
Removing the detector 26
Configuring the detector after installation 26
Connecting to a PC 28
Event log 30

Chapter 3 Commissioning 31
Introduction 32
Commissioning checklist 32
Precommissioning preparation 34
Acclimation period 34
Transport time verification 34
ASD System Performance Tests 34

Chapter 4 Troubleshooting 35
Troubleshooting the detector 36

Chapter 5 Maintenance 39
Introduction 40
Scheduled maintenance 40
Maintenance procedures 41
Glossary 45

Index 47
Important information

Regulatory information
This equipment is Class III as defined in EN 60950 (i.e., this equipment is designed to operate from Safety Extra Low Voltages and does not generate any hazardous voltages).

As this equipment is part of a fire detection system, input power should be supplied from an approved power supply conforming to EN 54-4 or UL/ULC and FM3230 standards.

In order for the installation to conform to EN 54-20, pipes must conform at least to EN 61386-1 Class 1131.

This product has been designed to meet the following requirements:

- NFPA 72 National Fire Alarm and Signaling Code
- UL 268 Smoke Detectors for Fire Alarm Signaling Systems
- UL 268A Smoke Detectors for Duct Applications
- UL 864 Control Units for Fire Protective Signaling Systems
- CAN/ULC-S524 Installation of Fire Alarm Systems
- ULC S527 Control Units for Fire Alarm Systems
- CAN/ULC-S529 Smoke Detectors for Fire Alarm Systems

System reacceptance test after reprogramming (UL/ULC and FM3230): To ensure proper system operation, this system must be retested in accordance with NFPA 72 after any programming change. Reacceptance testing is also required after any addition or deletion of system components, and after any modification, repair, or adjustment to system hardware or wiring.

Limitation of liability
To the maximum extent permitted by applicable law, in no event will UTCFS be liable for any lost profits or business opportunities, loss of use, business interruption, loss of data, or any other indirect, special, incidental, or consequential damages under any theory of liability, whether based in contract, tort, negligence, product liability, or otherwise. Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages the preceding limitation may not apply to you. In any event the total liability of UTCFS shall not exceed the purchase price of the product. The foregoing limitation will apply to the maximum extent permitted by applicable law, regardless of whether UTCFS has been advised of the possibility of such damages and regardless of whether any remedy fails of its essential purpose.

Installation in accordance with this manual, applicable codes, and the instructions of the authority having jurisdiction is mandatory.
While every precaution has been taken during the preparation of this manual to ensure the accuracy of its contents, UTCFS assumes no responsibility for errors or omissions.

Advisory messages

Advisory messages alert you to conditions or practices that can cause unwanted results. The advisory messages used in this document are shown and described below.

**WARNING:** Warning messages advise you of hazards that could result in injury or loss of life. They tell you which actions to take or to avoid in order to prevent the injury or loss of life.

**Caution:** Caution messages advise you of possible equipment damage. They tell you which actions to take or to avoid in order to prevent the damage.

**Note:** Note messages advise you of the possible loss of time or effort. They describe how to avoid the loss. Notes are also used to point out important information that you should read.

Product Symbols

This symbol appears on the main board of the unit and indicates that the board contains static sensitive components.

This label is located on the laser chamber at the bottom right of the open detector and signifies that the unit is a Class 1 Laser product as specified in IEC 60825-1. The unit incorporates a Class 3B embedded laser which must not be removed from the detector, as retinal damage may result if the laser beam enters the eye.

This symbol indicates the Safety ground studs. These are for grounding cable screens, etc., and should not be connected to 0V or signal earth.
EN 54-20 and UL installation

The installation must be designed using PipeCAD software. After designing the installation including pipes, endcaps, and sampling holes, enter the detector type. To select the detector type, click Options > Calculation options, and then select the detector from the Type drop-down list.

EN 54-20 installation

Select Options > Calculate, or click on the calculator icon. The software will prompt you to choose from Use set hole sizes, Best flow balance, and Max. permissible transit time. Select the appropriate option and click OK. The results for each pipe (View > Results) show calculations for each sampling hole on the pipe with the nearest to the detector at the top of the screen, and the endcap hole at the bottom.

For EN 54-20 compliance the transport time of the last sampling hole shall be checked following all installation and proven to be less than or equal to that determined by PipeCAD.

For the installation to comply with EN 54-20 Classes A, B, and C each sampling hole must be no less sensitive than 0.31% obs/m.

The calculation can be further refined by leaving a working detector in the protected area for at least 24 hours at the intended alarm factor for the installation (this could be done before or after installation). The detector sensitivity can be read from the Sensitivity figure on the histogram screen of the Remote Control software supplied with each detector. Click Options > Calculation options to open the Hole calculation options dialog box. Enter the sensitivity value obtained from the practical test, and then click OK. The new calculated value will use the real sensitivity from the practical test.

The PipeCAD software will determine the classification of any used configuration. Commissioning and periodic system tests must involve smoke tests to verify that the system performs as expected and enters Fire 1 alarm within the time determined by PipeCAD from the farthest hole. The detector sensitivity must also be inspected to ensure it has not radically fallen from the installed figure. If it has changed for any reason, the new figure must be re-entered into PipeCAD and the recalculated hole sensitivities must be confirmed to be within the class limits shown above. The settings of a compliant system should be recorded, as it is possible by changing certain programmable functions to make the system noncompliant. If functions are changed, it is recommended that the system is retested if continuing compliance is in any doubt.

UL installation

Note: UL certified products may also contain additional approvals, e.g. FM3230. Please refer to the product labels.
UL 268 fire tests were passed with an installation as follows:

- **Total sampling pipe length**: 160 ft. (single pipe)
- **Number of sampling holes**: 10
- **Worst-case sampling hole sensitivity as indicated by PipeCAD**: 1.28% obs/ft.*
- **Alarm factor**: 1
- **Fire 1 alarm delay**: 0 seconds

These settings gave satisfactory responses to the test fires in 120 seconds or better. For the purposes of UL 268 compliance, these should be regarded as worst case values. Layouts should be planned in PipeCAD and the indicated worst-case hole sensitivity should be better than 1.28% obs/ft.*. Commissioning smoke tests should be performed to ensure that the farthest sampling hole from the detector is capable of generating a fire alarm within 120 seconds of receiving smoke.

* The results should be verified at installation by entering the installed detector's Fire 1 sensitivity (as indicated in the remote software histogram screen) into the PipeCAD “Options/Calculation options/Detector sensitivity” field and recalculating the layout results.
Chapter 1
Product and component descriptions

Summary
This chapter provides descriptions of the detector features, specifications, and controls and indicators.

Content
Introduction  2
Available software for the detector  2
Specifications  3
Indicators  4
Inside the detector  5
Removable terminal block connections  6
Introduction

This aspirating detector is a highly sophisticated next generation high sensitivity aspirating smoke detection product that provides all the benefits of air sampling high sensitivity smoke detection, including very early warning. Designed for easy installation and commissioning, the detector incorporates a patented artificial intelligence known as ClassiFire, which allows the detector to configure itself to optimum sensitivity, alarm thresholds, and minimum nuisance alarms for various environments.

This detector operates by drawing air from a protected space via a supervised piping network in relatively small areas. The sampled air is passed through a dust separator (filter) to remove dust and dirt before entering the laser detection chamber. State-of-the-art electronics are used to analyse the sampled air and generate a signal representing the level of smoke present.

ClassiFire intelligence also monitors the detector chamber, continually adjusting the appropriate operating parameters to counteract the negative effects of any contamination. Aspirating smoke detectors are unique in being able to provide a consistent level of protection in a very wide range of environments by continuously making minor adjustments to sensitivity.

Available software for the detector

The Remote Control software package is available to program the detector.

- **Remote Control software**: Provided free of charge with every detector, this software package enables the user to set up and configure the programmable functions of one or more detectors from a computer connected via an RS-232 serial cable.
Specifications

Caution: This equipment is only to be used in accordance with these specifications. Failure to operate the equipment as specified may cause damage to the unit, injury, or property damage.

Table 1: Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELV rating</td>
<td>EN 60950 Class III</td>
</tr>
<tr>
<td>Supply voltage</td>
<td>21.60 to 26.40 VDC</td>
</tr>
<tr>
<td></td>
<td>PSU Type: conforming to EN 54-4</td>
</tr>
<tr>
<td></td>
<td>Electrical safety complies with BS EN 610190-1</td>
</tr>
<tr>
<td>Size</td>
<td>145 W × 220 H × 90 D mm</td>
</tr>
<tr>
<td></td>
<td>(5.7 W × 8.6 H × 3.5 D in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>1.7 kg (3.75 lbs.) with docking station</td>
</tr>
<tr>
<td>Operating temperature range</td>
<td>−10 to +60°C (EN 54-20)</td>
</tr>
<tr>
<td></td>
<td>32 to 100°F (0 to 38°C) (UL 268, CAN/ULC-S529, FM3230)</td>
</tr>
<tr>
<td>Operating humidity range</td>
<td>0 to 90% Noncondensing</td>
</tr>
<tr>
<td></td>
<td>BS EN 61010-1 Pollution degree 1</td>
</tr>
<tr>
<td></td>
<td>BS EN 61010-1 Installation category II</td>
</tr>
<tr>
<td>Sensitivity range</td>
<td>Min. = 7.62%, Max. = 0.00914% FSD</td>
</tr>
<tr>
<td>(%obs/ft.)</td>
<td>Min. = 25%, Max. = 0.03% FSD</td>
</tr>
<tr>
<td>(%obs/m)</td>
<td>0.0015% obs/m (0.00046% obs/ft.)</td>
</tr>
<tr>
<td>Detection principle</td>
<td>Laser light scattering mass detection</td>
</tr>
<tr>
<td>Particle sensitivity range</td>
<td>0.003 µm to 10 µm</td>
</tr>
<tr>
<td>Current consumption</td>
<td>250 mA</td>
</tr>
<tr>
<td>Relay contact rating</td>
<td>500 mA at 30 VDC</td>
</tr>
<tr>
<td>Optional relay input card contact rating</td>
<td>1 A at 24 VDC</td>
</tr>
<tr>
<td>Maximum sampling pipe length</td>
<td>50 m (165 ft.) total</td>
</tr>
<tr>
<td>Sampling pipe inlets</td>
<td>1</td>
</tr>
<tr>
<td>Sampling pipe internal diameter</td>
<td>3/4 in. (ID) or 27 mm (OD)</td>
</tr>
<tr>
<td>Alarm levels</td>
<td>4 (Fire 2, Fire 1, Pre-Alarm and Aux)</td>
</tr>
<tr>
<td></td>
<td>1 relay as standard, others available</td>
</tr>
<tr>
<td>Chamber service intervals</td>
<td>Greater than 8 years (depending on environment)</td>
</tr>
<tr>
<td>Dust separator (filter) replacement intervals</td>
<td>Greater than 5 years (depending on environment)</td>
</tr>
<tr>
<td>Laser lifetime (MTTF)</td>
<td>Greater than 50 years</td>
</tr>
<tr>
<td>Programming</td>
<td>PC via RS-232</td>
</tr>
<tr>
<td>IP rating</td>
<td>IP50</td>
</tr>
</tbody>
</table>
Indicators

Figure 1 shows the three indicators on the detector.

Figure 1: Detector indicators

(1) Fire: Illuminates when the alarm level has been reached and the appropriate time delays have expired.
(2) Fault: Illuminates when the unit has a fault and fault signal is being sent to the fire alarm panel. It also illuminates when the unit is isolated.
(3) OK: Illuminates to show normal operation when there are no faults. The OK lamp will flash during the 15-minute FastLearn period when the detector is first learning about its environment.
Inside the detector

Figure 2 shows the main interior parts of a detector with the cover off.

Figure 2: Detector interior view (EN/UL certified models)

(1) Removable terminal block connections
(2) Filter (dust separator)
(3) RS-232 serial port
(4) Detector address DIP switch
(5) Addressable Programmable Interface Card (APIC) or Relay Card port
(6) Internal cover (UL certified models only)
Removable terminal block connections

Figure 3 shows the terminal block connections that connect the detector to other electronic components.

Figure 3: Detector terminal block connections

(1) Fault relay contacts (Open = FAULT)
(2) Fire relay contacts (Closed = FIRE)
(3) APIC addressable bus connections for use in conjunction with interface card
(4) Connections are not applicable for Micra 10
(5) Power supply connections
Chapter 2
Installation and configuration

Summary
This chapter provides information necessary to install and configure the detector system.

Content
Introduction  8
Antistatic precautions  8
General installation guidelines  10
Docking station  10
Application  12
System design  12
  Below or above the ceiling installations  14
Installation  17
  Mechanical installation  17
  Removing the front cover  17
  Electrical installation  17
  Relay connections  20
Interfacing with fire alarm panels  21
  Connecting a detector to an APIC  22
Setting the detector address  23
  Address table  23
Final installation  25
Removing the detector  26
Configuring the detector after installation  26
  List of programmable functions  27
Connecting to a PC  28
Event log  30
Introduction

This topic provides information necessary to install the detector system.

To install the detector:

1. Unpack the shipping carton. Ensure that the package contains a CD-ROM, two ferrite rings, two cable glands, and the unit.
2. Determine the optimum location for the detector.
3. Mount the APIC or Relay Card inside the detector, if required.
4. Mount the docking station.
5. Connect the docking station to the sampling pipe network.
6. Mount the detector to the docking station.

Installation should only be done by trained technicians.

Note: Each relay card is supplied with a RF suppression ferrite ring. To ensure compliance with all relevant EMC requirements, conductors connected to the fault output (included screen wire) should be wound once around a ferrite.

Installation should be in accordance with applicable installation requirements. These include:

- NFPA-70, National Electrical Code
- NFPA-72, National Fire Alarm and Signaling Code
- CSA C22.1 Canadian Electrical Code, Part 1
- CAN/ULC-S524 Installation of Fire Alarm Systems
- Any other local, national, or installation requirements or standards.

WARNING: Electrocution hazard. All connections should be made with the power turned off.

Antistatic precautions

This system contains static-sensitive components. Always ground yourself with a proper wrist strap before handling any circuits. This recommendation must be followed when removing the equipment case, and during installing and servicing.

Caution: When handling any electric components or printed circuit boards, antistatic precautions must be followed. Failure to do so may result in component damage.

Electro-static discharge can be reduced by adhering to the following guidelines:

- Always use conductive or antistatic containers for transportation and storage, if returning any item.
- Wear a wrist strap while handling devices and ensure that a good ground is maintained throughout the installation process.
• Never subject a static sensitive device to sliding movement over an ungrounded surface and avoid any direct contact with the pins or connections.
• Avoid placing sensitive devices onto plastic or vinyl surfaces.
• Minimise the handling of sensitive devices and printed circuit boards (PCBs).
General installation guidelines

The following is a brief set of guidelines on installing detectors:

- The detector should normally be mounted at a level where there is easy access to the RS-232 serial port for configuration and programming.

- The exhaust air from the unit must not be impeded in any way. If the unit is mounted where the air pressure differs from the sampling location (for example an air duct), then a pipe must be routed from the exhaust port back to the same air pressure zone as the sampling holes.

- Sampling holes should be free from burrs and swarf.

- All signal cables must be suitable for the application. The specific type of cable will normally depend upon the local fire regulations.

- The unit must not be placed in areas where either the temperature or humidity is outside the specified operating range.

- The unit should not be placed in close proximity to any equipment expected to generate high levels of radio frequency signals (such as radio alarms) or units generating high levels of electrical energy (such as large electric motors or generators).

Docking station

The basic principle behind the easy installation of the detector is that all wiring and pipework is installed using a docking station. This is a convenient feature that allows the detector to be dismounted or replaced without disturbing any wiring or installed pipework.

The docking station inlet (sampling) port and exhaust port is used to interface with the pipe network. The inlet port is used for aspirating the pipework network. The exhaust port allows the detector exhaust air to be routed back to the sampling area, when differing atmospheric pressures require this. (Refer to Figure 4.)
Figure 4: Docking station

(1) Cable gland
(2) Earth stud
(3) Exhaust port
(4) Sampling port
(5) Mounting screw holes
Application

This detector is a smoke detector intended to provide localised incipient fire detection. It is suitable for use in a wide range of applications, such as small non-compartmentalised rooms, warehouse racking, or pieces of electronic or electromechanical equipment where it is desirable to achieve individual incipient fire reporting. In compartmentalised rooms, each compartment would normally use individual aspirating detectors.

The detector employs a low-power aspirator (fan) designed to detect incipient fires in relatively small areas. The detector is not intended to protect large areas, or to sample from areas where there may be any difference in airflow rates or pressure differentials. If detection in environments conforming to these descriptions is required, other type detectors should be used.

System design

Simple designs with short sampling pipes produce the best results. Complex sampling pipe runs should be avoided with the detector. The use of T-branch pipes is not recommended. Maximum recommended sampling pipe length is 50 m (165 ft.) in still air. If the protected area has airflow present, the maximum permitted sampling pipe length will be reduced.

Note: PipeCAD pipe modeling software must be used when designing a pipe network and verifying its performance. Refer to the PipeCAD System Design and Installation User Guide for complete instructions on how to design and install an air sampling pipe network.

In order for the installation to conform to EN 54-20, pipes must conform at least to EN61386-1 Class 1131.

Sampling pipes must have capped ends. The end cap should be drilled with a hole normally between 4 or 5 mm diameter and free from burrs. Sampling holes should normally be 3 to 4 mm diameter or as calculated by PipeCAD, and free from burrs. Each pipe run should not have more than 10 holes (including the end cap hole). Pipe transit time from the furthest sampling hole from the detector must not exceed 120 seconds and an approved type of pipe must be used. It is strongly recommended that the smoke transit time from the furthest sampling hole be checked during commissioning tests.

Capillary remote sampling points may be used in place of sampling holes.

Always locate the sampling points in positions to which smoke may reasonably be expected to travel. It is usually better to locate the sampling pipe directly in the airflow (for example, across the return air register of an air conditioning unit).

Note: There is no substitute for carrying out smoke tests prior to installation of pipework to indicate suitable sampling point location.
No more than one air handling unit may be protected with one detector. In this application, ensure that the sampling pipe is raised clear of high velocity air in the immediate vicinity of the air intake grill on standoff posts as shown in Figure 5.

Figure 5: Air handling unit in vicinity of the detector (exhaust shown for clarity)

(1) Incorrect location
(2) Detector
(3) Sampling pipe
(4) Standoff posts
(5) Correct location
(6) Detector
(7) AHU
(8) Equipment cabinet
(9) Direction of smoke
Below or above the ceiling installations

The detector is supplied with a docking station (as shown in Figure 4 on page 11). This allows the detector to sample from areas which may be at different air pressure from the detector location. Typical uses are for air duct sampling and allowing the installation of the detector in under-floor or ceiling voids or when sampling from pieces of computer related equipment. See Figure 6 and Figure 7.

Figure 6: Installation of pipework above ceiling with exposed detector (piped exhaust)

(1) Sampling pipe
(2) Sampling hole
(3) Detector
(4) Exhaust pipe
(5) False ceiling
Figure 7: Installation with detector mounted in ceiling void (no exhaust piping)

(1) Sampling pipe
(2) Sampling hole
(3) Detector
(4) False ceiling
Table 2 below contains a list of procedural guidelines for installation of the detector.

Table 2: Procedural guidelines

<table>
<thead>
<tr>
<th>Do</th>
<th>Don’t</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure that the power and signal cables are correctly connected before powering up by use of cable identifiers or electrical continuity checks. Incorrect connection could damage the detector.</td>
<td>Drop the detector.</td>
</tr>
<tr>
<td>Ensure that cable of an appropriate approved type is used for interconnection.</td>
<td>Install detectors in damp or exposed areas.</td>
</tr>
<tr>
<td>Place sampling points so that the detector will be able to detect smoke at the earliest opportunity.</td>
<td>Remove or connect boards when the detector is powered up.</td>
</tr>
<tr>
<td>Ensure that the detector exhaust is in an area with the same atmospheric pressure as the sample pipes, either by placing the detector physically in the protected area or by leading a pipe from the detector exhaust to the protected area.</td>
<td>Connect internal 0 volt terminals to local earth.</td>
</tr>
<tr>
<td>Ensure that the environment of the protected area is within the environmental operating parameters of the detector.</td>
<td>Attempt to re-use dust separator (filter) cartridges once removed.</td>
</tr>
<tr>
<td>Set the appropriate ClassiFire alarm factor for the area to be detected.</td>
<td>Attempt to adjust or alter detector settings other than via the user-programmable functions. Any attempts to adjust the laser potentiometer are detectable and will void the warranty on the product.</td>
</tr>
<tr>
<td>Set the detector address switches correctly when used in a network.</td>
<td>Place the detector near high power RF sources.</td>
</tr>
<tr>
<td>Ensure that the detector is properly grounded.</td>
<td>Place the detector so close to other equipment that there is insufficient room to access and change the dust separator (filter) or access the RS-232 connector.</td>
</tr>
<tr>
<td></td>
<td>Use sampling pipe of less than 27 mm (1 in.) outside diameter without a suitable 27 mm (1 in.) pipe adapter. It is important that there are no leaks where the pipe connects to the detector.</td>
</tr>
<tr>
<td></td>
<td>Use excessive force when fitting sampling pipes as this may damage the detector.</td>
</tr>
</tbody>
</table>
Installation

Mechanical installation
The docking station is connected to the installed sampling pipework and fixed to the mounting surface using three screws of a type appropriate to the mounting surface. Ensure that the sampling and exhaust pipes are securely seated in the pipe ports before securing. If using a piped exhaust docking station, be sure that the sampling and exhaust pipes are fitted into the relevant ports as shown in Figure 4 on page 11.

Removing the front cover
To remove the front cover, unfasten the four attachment screws on the front of the unit. The cover may then be removed.

Electrical installation
The detector is supplied with removable terminal blocks (Refer to Figure 3 on page 6.) These may be removed from their sockets by lifting them up at right angles to the circuit board.

Take note of the orientation of each terminal block and its function before removing it. It may also be beneficial to mark the connection wires with suitable identification labels or colored rings to aid in the connection process.

Each detector is supplied with a pair of RF suppression ferrite rings. To ensure compliance with all relevant EMC requirements, the conductors of each cable should be wound once around a ferrite as shown here before entering the relevant connector. Power conductors should be on a separate ferrite, but different forms of signal conductor (e.g. APIC signals and relays) can share the same ferrite. There should be about 30 mm (1-1/4 in.) of wire between the end of the ferrite and the terminal block to give adequate stress relief. To achieve this, it is necessary to strip back the cable screen approximately 130 mm (5 in.). The screen should be terminated under the cable gland cap (as shown in Figure 8).
WARNING: Electrocution hazard. All connections should be made with the power turned off.

Power supply connections

The power supply cable should be the shielded (screened) type and should be routed through the metal cable gland provided, leaving about 35 mm (1-1/4 in.) of the cable extending from the bottom of the cable gland. Depending on the type of cable used, it may be necessary to increase the diameter of the cable with sleeving or insulating tape to ensure that the cable is firmly held when the cable gland is fully tightened.

Note: It is important that you are aware of the orientation of the terminal block before removing it.

To connect the power supply:

1. Remove the detector front cover and detach the power supply terminal block, located at the top left inside the detector. (Refer to Figure 2 on page 5 for a photograph of the detector with the front cover removed. Refer to Figure 9 for a detailed photograph of the power supply terminals.)

2. Connect 0 V and +24 VDC to the 0V and 24V screw terminals respectively.

3. Connect the shielded (screened) wire to the ground stud on the docking station.

4. Connect a second wire from the Earth terminal to the docking station ground stud. Figure 4 on page 11 shows the location of the ground stud.

5. Connect the ground wires to the ground stud.
Signal connections

To connect the signal wire:

1. Lead a suitable wire type (RS-485 cable 9841, 120 ohm shielded (screened) twisted pair or equivalent) through the second cable gland.

2. Tighten it into position with approximately 35 mm (1-1/4 in.) of cable from the bottom of the cable gland.

3. Remove the four-way Bus terminal block (if connecting the detector to an alarm panel in conjunction with the APIC addressable bus card). Refer to Figure 10 for an illustration of the terminals and “Setting the detector address” on page 22 for details on addressing.

Figure 11 shows the power and signal connections to the docking station for connection to a single network cable.
Relay connections

The detector includes a Fire relay (corresponding to the Fire 1 alarm level), which closes on alarm, and a general Fault relay, which opens on any fault condition or on power-down (see Figure 12). The relays are of the volt-free type, with a maximum current capacity of 500 mA at 30 VDC maximum. Connect the screen of the relay cables to the ground stud of the detector.
Interfacing with fire alarm panels

Because of the flexible nature of the detector and the many possible configurations, there are many options for interfacing the detectors to a fire panel. The detector provides the following methods of interfacing with fire alarm panels:

- To conventional fire alarm panels using the detector’s Fire and Fault relay contacts
- To addressable fire alarm panels, or standard loop interface modules via Addressable Programmable Interface Cards (APICs)

APICs, which can be mounted inside the detector, may simplify installation when connecting to addressable signaling line circuits (SLC). The APIC used is completely dependent on the SLC protocol, and therefore the make and model of the fire alarm panel.

**WARNING:** Incompatible APIC panel combinations may result in a non-operational system which may fail to perform during an event, with resultant loss of life and/or property.

The interface is set to a single address mode, the card appears as a single address on the SLC, and the detector status is read from that address.
Connecting a detector to an APIC

The APIC is fitted to the four mounting studs on the detector PCB using the supplied screws as shown Figure 13 below.

The connections to the fire panel are made using the BUS L1 and H1 (bus 1 input and output) and the BUS L2 and H2 (bus 1 input and output) terminal connectors shown in Figure 10 on page 19.

The settings that need to be made are on the APIC address DIP switches. Both switches (SW1, SW2) must be set to the same address.

Note: Some protocols may not support all the available alarm levels and fault reporting is usually a general fault with no detailed fault information. Please consult the specific APIC protocol documentation for more information.

Figure 13: APIC connections (EN/UL certified models)
Setting the detector address

In order to identify itself to the PC command module or fire panel, each detector needs to have a unique address ranging from 1 to 127. The detector address is set on DIP switch SW1, at the bottom left of the opened detector on the main circuit board. The switch settings are up for 1 and down for 0, and the detector address is set as a 7-bit binary code (switch 8 equates to a value of 128 and so is outside the usable address range). Refer to Figure 2 on page 5 for the location of the detector DIP switches.

Figure 14 shows a sample DIP switch setting.

The address equates to 11000110 in binary, or:

\[(1 \times 1) + (1 \times 2) + (0 \times 4) + (0 \times 8) + (0 \times 16) + (1 \times 32) + (1 \times 64) + (0 \times 128) = 99\]

The full range of available addresses and their relevant switch settings are provided in Table 3 on page 24 for reference.

Address table

Addresses chosen for detectors do not have to be consecutive or in a given order as long as they are all different. Table 3 on page 24 provides the address table for detectors.
### Table 3: Address table

<table>
<thead>
<tr>
<th>Address</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>26</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>27</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>28</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>29</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>30</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>33</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>34</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>35</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>36</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>37</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>38</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>39</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>40</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>41</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>42</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>43</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>44</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>45</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>46</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>47</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>49</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>50</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>51</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>52</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Final installation

Once the power and signal connections are made, slide the detector body up into the docking station and fasten it into position using the M4 pan head screws provided. Slot the power and signal terminal blocks into the relevant sockets on the detector PCB (which will only click fully home in the correct orientation). Lastly, replace the detector cover using the four M3 pan head screws provided. Refer to Figure 15.

Note: The detector is designed solely for operation with the front cover securely fitted using all four mounting screws.
Removing the detector

Removing the detector is the reverse of the installation process, leaving the pipework and wiring connections installed in the docking station (as shown in Figure 11 on page 20). See Figure 15 above.

Configuring the detector after installation

The detector programmable functions are accessed using a PC (connected to the detector) running the Remote Control software program.
Remote Control software

Provided free of charge with every detector, the Remote Control software package enables the user to set up and configure the programmable functions of one or more detectors or command module from a computer connected via an RS-232 serial cable. Complete instructions on how to install, launch, and use the Remote Control software is provided in the Remote Control Software User Guide under separate cover.

List of programmable functions

In the Remote Control program, the tabbed Functions Settings window contains all of the available programmable functions.

For details about these functions refer to the manual provided separately:

- Remote Control Software User Guide

To change one of the programmable functions, go to the relevant tab, make the change, and then click OK to save the changes to the detector's internal firmware.

The following programmable functions are available:

- Time and Date
- Alarm Levels
- Alarm Delays
- ClassiFire Override (when optional Input/Relay card is installed)
- Alarm Factor
- LDD Enable
- FastLearn Enable
- Auto FastLearn Enable
- ClassiFire 3D
- Demo Mode
- Day Start/Night Start
- Disable Day/Night Switching
- Remote Functions (when optional Input/Relay card is installed)
- Programmed Isolate
- Latching Alarms
- Latching Faults
- Cascading Alarms
- Device Type (reference only)
- Firmware Version
- Run-time Hours
- Watchdog Count (reference only)
- Device Text
- Flow Rate (reference only)
- Flow High Limit
- Flow Low Limit
- Flow Fault Delay
Connecting to a PC

To connect a single stand-alone detector to a PC, connect the PC’s serial port directly to the detector’s 9-way RS-232 port. Connections for this cable are shown in Figure 16. If required, you use a USB to serial RS-232 adapter cable to connect to the PC USB port.

Figure 16: RS-232 cable connections

(1) 9 pin female D connector
(2) 9 pin female D connector

Figure 17 shows the RS-232 cable connection from the detector to a PC.
Figure 17: Detector serial port connection for a PC

(1) Serial port connection (to PC)

(2) Gender changer required (UL certified models only)
Event log

The Event Log is a record of detector events such as faults, alarms and function changes. It is stored inside an operating detector and is updated whenever an event occurs. The event log is nonvolatile, which means that it is retained when the detector is turned off. The last 200 detector events may be stored.

An event is defined as:

- A change to any programmed function
- A signal received from an external controller such as the remote software or APIC
- A detector output level meeting or exceeding the Pre-Alarm, Aux, Fire 1, or Fire 2 alarm thresholds
- A start of day or night operation
- Demonstration Mode start
- FastLearn start or stop
- Power on or off

Events can either be viewed on a PC screen or downloaded to disk by running the Remote Control program.

When the detector event log is full (200 events have been logged) and a new event occurs, the oldest event in the log is deleted (first-in, first-out).

To download the event log, connect a PC to the detector serial port and run the Remote Control software program. For details, see the Remote Control Software User Guide.
Chapter 3
Commissioning

Summary
This chapter provides information to commission the detection system.

Content
Introduction  32
Commissioning checklist  32
Precommissioning preparation  34
Acclimation period  34
Transport time verification  34
ASD System Performance Tests  34
**Introduction**

This chapter covers the commissioning procedures for the detector. Commissioning strategy initially depends upon the environment in which the detector is installed. For instance, the test for a computer room (in a relatively clean environment) would be very different from, say, a flour mill, with a high level of airborne particulate content.

A widely accepted standard for computer rooms or EDP areas is British Standard BS6266, equipment overheating at a stage well before combustion. To perform the test electrically overload a 1-metre length of PVC insulated wire of 10/0.1mm gauge for one minute using an appropriate power supply. The detector has two minutes from the end of the wire burn to give an alarm indication.

For areas with higher levels of background particulate matter testing methodology would be similar to that of standard point detectors.

Commissioning should only be done by trained technicians in accordance with applicable standards.

**Commissioning checklist**

The following brief checklist allows quick setup of the detector. This procedure will be adequate for most standard installations.

**To commission the detector:**

1. Before powering up the detector, visually check all cabling to ensure correct connection. If wire identification is not immediately clear (e.g., by use of different colored wires or wire identification sleeves), an electrical check should be made.

   **Caution:** Ensure that all wiring connections are checked prior to powering up the detector. Incorrect wiring of the detector will cause permanent damage to the detector.

2. Connect the detector to a PC and set the detector address on the DIP switches and APIC board (if applicable). Refer to “Interfacing with fire alarm panels” on page 21 and “Setting the detector address” on page 22 for more information.

3. Power up the detector.

4. Ensure that all detectors in the network area are clear of troubles and alarms (if applicable).

5. Launch the Remote Control software on the computer, enter the access code, and select the Function Settings window.

6. Verify that the time and date are correct on the Time and Date tab.

7. Set an appropriate alarm factor, as shown in Table 4 on page 33, for the protected environment on the Alarm Levels and Delays tab. The detector will
automatically perform a FastLearn for the new alarm factor (which takes approximately 15 minutes). The OK indicator on the front panel will begin to flash. If using Day/Night switching, check that Day Start and Night Start settings reflect site operations.

8. While the detector is still in FastLearn mode, place a checkmark next to the Demo Mode command at the bottom of the Alarm Levels and Delays screen. The detector will enter demo mode (where it estimates its final sensitivity) immediately after the FastLearn cycle has finished.

Note: Checking the Demo Mode box only puts the detector into demo mode while the detector is performing a FastLearn. It has no effect at any other time.

9. Verify that the FastLearn has concluded (the OK indicator has stopped flashing). With the detector in demo mode, perform any necessary smoke tests, ensuring that the detector reacts appropriately, and let the smoke fully dissipate.

10. Perform another FastLearn, this time by NOT putting the detector into demo mode. Do this by placing a checkmark next to the FastLearn Enable command in the Alarm Levels and Delays screen. The OK indicator on the front panel will begin to flash.

11. The detector will generate no alarms during the 15 minute FastLearn period and, after this, the detector will operate at a reduced sensitivity for 24 hours while ClassiFire learns and acclimates to the protected environment and sets up appropriate day and night sensitivity settings.

12. If desired, exit the Remote Control software and unplug the connector from the detector serial port.

Table 4: Suggested settings for ClassiFire alarms

<table>
<thead>
<tr>
<th>Alarm factor</th>
<th>Sensitivity</th>
<th>Probability of nuisance alarm</th>
<th>Suggested protected area</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Extremely High</td>
<td>Once per year</td>
<td>Semiconductor manufacturing clean room</td>
</tr>
<tr>
<td>1</td>
<td>High</td>
<td>Once per 5 years</td>
<td>Computer room</td>
</tr>
<tr>
<td>2</td>
<td>High</td>
<td>Once per 10 years</td>
<td>Non-smoking office</td>
</tr>
<tr>
<td>3</td>
<td>High</td>
<td>Once per 50 years</td>
<td>Clean factory</td>
</tr>
<tr>
<td>4</td>
<td>Medium</td>
<td>Once per 1,000 years</td>
<td>Warehouse</td>
</tr>
<tr>
<td>5</td>
<td>Medium</td>
<td>Once per 5,000 years</td>
<td>Warehouse with diesel trucks operating</td>
</tr>
<tr>
<td>6</td>
<td>Medium</td>
<td>Once per 10,000 years</td>
<td>Warehouse with diesel trucks operating</td>
</tr>
<tr>
<td>7</td>
<td>Low</td>
<td>Once per 20,000 years</td>
<td>Warehouse with diesel trucks operating</td>
</tr>
<tr>
<td>8</td>
<td>Low</td>
<td>Once per 100,000 years</td>
<td>Warehouse with diesel trucks operating</td>
</tr>
</tbody>
</table>
Precommissioning preparation

Commissioning should be performed after all construction has been completed and cleaned of any lingering post-construction dirt. If ambient monitoring conditions are recorded before the installation is cleaned up, they may not accurately reflect actual normal operating conditions that need to be used as reference data for follow-up maintenance procedures and tests.

Acclimation period

The detector will operate at a reduced sensitivity for 24 hours. ClassiFire will set up the appropriate day and night sensitivity settings. All air handling units, thermostats and other systems that can have an effect on the operating environment should be turned on to simulate normal operating conditions as closely as possible. After approximately one week of monitoring time (depending on chart log recording rate), download the detector event log to a PC from the RS232 port using a serial cable.

Transport time verification

The maximum transport time verification test is the measure of the amount of time it takes for the detector to respond to smoke that enters the pipe at the sampling point furthest from the Detector. The results of this test and the calculated maximum transport time from PipeCAD must be recorded on the checksheet. Measured transport time less than the calculated time is acceptable.

To measure the maximum transport time of the system:

1. Determine the furthest sampling point from the detector.
2. Allow test smoke to enter the pipe at the furthest sampling point.
3. Record the amount of time for the detector to respond. This is the actual maximum transport time.

ASD System Performance Tests

Note: It is recommended to follow local codes of practice for approved tests for this type of installation.

Caution: Oil-based canisters that are used to test point detectors are not suitable for testing aspirating systems, as the particulate is heavy and tends to drop out in the pipe, never actually reaching the detector. Also, the oily residue that is left behind may affect the functionality of the detector.
Chapter 4
Troubleshooting

Summary
This chapter provides information to troubleshoot the detection system.

Content
Troubleshooting the detector  36
Troubleshooting the detector

This chapter provides some possible solutions if a problem should occur with your detector.

**Note:** Consult either the *Remote Control Software User Guide* for more information about the solutions or corrective actions discussed here.

Table 5: Troubleshooting guide

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution/Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuisance alarms occur too often</td>
<td>Check that the ClassiFire alarm factor setting is appropriate for the normal working environment of the protected area.</td>
</tr>
<tr>
<td></td>
<td>Check that the detector is not in demo mode. This can be ascertained by viewing the event log and checking that the entry demo mode has a higher log entry number than the most recent FastLearn start and FastLearn end entries. Note: Remember that the log entries are in reverse order, with the most recent entries appearing first. If the log shows that demo mode was invoked during the last FastLearn period, start a new FastLearn and allow it to complete its 24-hour cycle. From the event log, check that 24 hours have elapsed since the last FastLearn end entry. Check that day-night switchover times are appropriately set to reflect active and nonactive periods.</td>
</tr>
<tr>
<td>Elevated smoke levels do not generate alarms</td>
<td>Check that detector is not isolated or in FastLearn (if Isolated, the Fault light will be lit; if in FastLearn, the OK light will flash). Check that the detector sampling points are in the smoke stream. Check that sampling pipes are firmly and cleanly seated in their ports and undamaged. Check that the correct ClassiFire alarm setting has been set. Check that the detector has either had a 24-hour learning period or that it has been placed in demo mode.</td>
</tr>
<tr>
<td>Low mean output</td>
<td>Check that the dust separator (filter) cartridge does not require changing (refer to “Replacing the dust separator cartridge” on page 42 for details) and that the air plenum chamber is clean. The chamber may become clogged when, for example, heavy building activity has occurred near the sampling pipes. If so, the chamber may require factory service. The detector is not designed to handle large quantities of coarse debris and dust.</td>
</tr>
<tr>
<td>Detector sensitivity varies over time</td>
<td>There are many reasons why particle densities may vary, and the ClassiFire system is designed to automatically compensate for this in order to reduce the likelihood of nuisance alarms due to normal variations in background smoke density. Within limits set by the ClassiFire alarm factor, this is a normal part of the detector’s operation.</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution/Corrective Action</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Flow fault errors</td>
<td>These occur when the airflow rate into the detector exceeds the preprogrammed parameters. As the detector “learns” the flow setup from the initial installation, this usually means that there has been some change in conditions. If the detector input is sampled from one area and the exhaust is in another area with different pressure (e.g., the detector is in a roof space and sampling from an enclosed room), this may lead to flow faults. In this case, it would be necessary to lead a pipe from the exhaust to the protected area to ensure nominal flow.</td>
</tr>
<tr>
<td>Low Flow error message</td>
<td>Check that the pipe is not blocked. If the pipe is unused, check that the flow sensor for this pipe has been disabled. Check that the low flow fault threshold is not set too high. In the case of intermittent fault indications, try increasing the flow fault delay time.</td>
</tr>
<tr>
<td>High Flow error message</td>
<td>Check that the pipe is seated in the inlet and is not broken or cracked. Check that installed pipework is fitted with endcaps. PipeCAD pipe modeling software prompts for the use of appropriate endcaps. Open bore pipes are not recommended. Check that the high flow fault threshold is not set too low. In the case of intermittent fault indications, try increasing the flow fault delay time.</td>
</tr>
</tbody>
</table>
Troubleshooting
Chapter 5
Maintenance

Summary
This chapter provides scheduled and unscheduled maintenance procedures.

Content
Introduction 40
Scheduled maintenance 40
Maintenance procedures 41
    Visual check 41
    ASD System Performance Tests 41
    Transport time verification test 41
    Detector sensitivity test 41
    Cleaning the detector 42
    Replacing the dust separator cartridge 42
Introduction
This chapter contains maintenance instructions for the detector system. These procedures should be performed on a scheduled basis. In the event that system problems are found during routine maintenance, refer to Chapter 4 “Troubleshooting” on page 35 Failure to properly maintain the system may affect the functioning of the system.

Scheduled maintenance
The scheduled maintenance of the system should be performed at an established interval. The interval between performance of maintenance procedures should not exceed any imposed regulations. (See NFPA-72 or other local requirements.)

Local standards and specification requirements must be adhered to. A typical maintenance plan is listed in Table 6 below.

Notes
It is prudent to disconnect or isolate the detector from the fire panel during maintenance to prevent unintentional alarm activations.

The detector should be powered down during internal cleaning (use an air duster can or dry air gun).

Table 6: Maintenance plan
<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Check detector, wiring and pipework for damage</td>
</tr>
<tr>
<td>2</td>
<td>Check original design is still valid, e.g. changes due to building upgrades</td>
</tr>
<tr>
<td>3</td>
<td>Check detector for contamination and clean if necessary</td>
</tr>
<tr>
<td>4</td>
<td>Check maintenance logs for issues and rectify as appropriate</td>
</tr>
<tr>
<td>5</td>
<td>Check transport times against original records: significant increases or decreases in transport times may imply damaged pipes or sampling holes that need clearing</td>
</tr>
<tr>
<td>6</td>
<td>Isolate detector from fire panel if required</td>
</tr>
<tr>
<td>7</td>
<td>Smoke test to check detector operation and Alarm relay connection</td>
</tr>
<tr>
<td>8</td>
<td>Simulate a fault to check the Fault relay and connection</td>
</tr>
<tr>
<td>9</td>
<td>Complete and file maintenance records</td>
</tr>
<tr>
<td>10</td>
<td>Reconnect detector to fire panel if required</td>
</tr>
</tbody>
</table>
Maintenance procedures

The following paragraphs outline general scheduled maintenance procedures to be performed on an “as necessary” basis.

Caution: Risk of equipment damage. Always turn the power off before servicing the detector.

Visual check

The visual check must be performed every six months. This check is to ensure pipe network integrity.

To perform the visual check, observe the entire piping network and check for abnormalities in the pipes, including any breaks, blockages, crimps, etc.

ASD System Performance Tests

Note: It is recommended to follow local codes of practice for approved tests for this type of installation.

Transport time verification test

The maximum transport time of the pipe network must be measured and compared to the recorded transport time at commissioning. (Refer to “Transport time verification” on page 34 of this manual for test details.) The transport time verification test must be done at commissioning and every year thereafter.

Detector sensitivity test

The detector sensitivity test must be performed within one year of installation and every alternate year thereafter.

Example:

- Year-one check
- Year-three check
- If years one and three are OK, go to five-year interval.

The detector employs a self-monitoring, automatically-adjusting calibration for the system. The inspection only requires a periodic visual inspection for a detector fault indication and performing the detector sensitivity test function.

If the self-monitoring feature of the system senses that the operation of the detector head is outside its normal range, a trouble condition will be generated.
Cleaning the detector

The exterior of the detector should be cleaned as necessary. Clean the detector with a damp (not wet) cloth. Do not use solvents as these may damage the front panel label.

Caution: Do not use solvents to clean the detector. Use of solvents may cause damage to the detector.

Replacing the dust separator cartridge

The only part that may require field replacement during servicing is the dust separator (filter) cartridge.

After replacing the filter, the detector must be put into FastLearn mode.

As dust contained in the dust separators may expose maintenance personnel to a “Nuisance Dust” hazard as defined by the Control of Substances Hazardous to Health (COSHH), it is strongly recommended that suitable masks and protective clothing be worn when changing filters.

Note: Used dust separator cartridges are not intended for reuse and should be discarded.

To replace the cartridge:

1. Remove the four attachment screws which fasten the unit’s front cover.
2. With the front cover removed, grasp the filter firmly and pull the filter out (directly towards you).
3. Properly dispose of the used cartridge.
4. Insert the replacement filter cartridge such that the orientation of the Direction of flow arrow printed on the cartridge corresponds to the arrow on the “Direction of flow” label beside the filter slot.
5. Slide the cartridge all the way into place.
6. Replace the detector cover and screws and initiate a FastLearn routine.
Figure 18: Location of dust separator cartridge

(1) Dust separator (filter) cartridge
Glossary

°C Degrees centigrade
°F Degrees Fahrenheit
A Ampere
AC Alternating current
ADA Americans with Disabilities Act
AH Ampere hour
AHJ Authority having jurisdiction
ARC Automatic release circuit
ASD Aspirating Smoke Detector
AWG American wire gauge
APIC Addressable protocol interface card
CSFM California State Fire Marshal
DACT Digital alarm comm. transmitter
DC Direct current
DET Detector
EOLD End of line device
EOLR End of line resistor
FSD Full scale deflection
FM Factory Mutual
ft. Feet
HSSD High sensitivity smoke detector
Hz Hertz (frequency)
in. Inches
LCD Liquid crystal display
LED Light emitting diode
MEA Materials and Equipment Acceptance
Division of the City of New York
NAC Notification appliance circuit
N.C. Normally closed
NEC National Electrical Code
NFPA National Fire Protection Association
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N.O.</td>
<td>Normally open</td>
</tr>
<tr>
<td>NYC</td>
<td>New York City</td>
</tr>
<tr>
<td>PCB</td>
<td>Printed circuit board</td>
</tr>
<tr>
<td>pF</td>
<td>Pico farads</td>
</tr>
<tr>
<td>P/N</td>
<td>Part number</td>
</tr>
<tr>
<td>PSU</td>
<td>Power supply unit</td>
</tr>
<tr>
<td>RAM</td>
<td>Random access memory</td>
</tr>
<tr>
<td>SLC</td>
<td>Signaling line circuit</td>
</tr>
<tr>
<td>TB</td>
<td>Terminal block</td>
</tr>
<tr>
<td>UL/ULI</td>
<td>Underwriters Laboratories, Inc.</td>
</tr>
<tr>
<td>V</td>
<td>Volts</td>
</tr>
<tr>
<td>VAC</td>
<td>Volts AC</td>
</tr>
<tr>
<td>VDC</td>
<td>Volts DC</td>
</tr>
<tr>
<td>VRMS</td>
<td>Volts root mean square</td>
</tr>
</tbody>
</table>
Index

A
Acclimation period, 34
Addressing
  Address table, 23
  Setting the detector address, 23
Advisory messages, iv
Application, 12
ASD System Performance Tests, 34

C
Commissioning, 32
Configuring the detector, 26
Connecting to a PC, 28

D
Detector components, 5
Docking station, 10

E
Event log, 30

F
Fire Alarm Panels
  Interfacing, 21

I
Indicators, 4
Installation, 10
  Electrical, 17

M
Maintenance, 41
  Cleaning the detector, 42
  Replacing the dust separator (filter), 42

P
Power supply connections, 18
Programmable functions, 27

R
Relays, 20
Removing the detector, 26

S
signal connections, 19
Software
  Available software, 2
  Specifications, 3
  System design, 12

T
Terminal blocks, 6
Transport time verification, 34
Troubleshooting, 36